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Abstract- The global demand for wood as a building material 

is steadily growing, while the availability of this natural 

resource is diminishing. This situation has led to the 

development of alternative materials. Of the various synthetic 

materials that have been explored and advocated, composites 

claim a major participation as building materials. There has 

been a growing interest in utilizing natural fibres as 

reinforcement in composite for making low cost construction 

materials in recent years. Natural fibres are prospective 

reinforcing materials and their use until now has been more 

traditional than technical. Among the various natural fibres, 

Sisal and Abaca is of particular interest in that its composites 

have high impact strength besides having moderate tensile and 

flexural properties compared to other lignocelluloses fibres. In 

this project surveyed the research work published in the field of 

Sisal and Abaca and reinforced polymer composites with 

special reference to the structure and properties of Sisal and 

Abaca, processing techniques, and the physical and mechanical 

properties of the composites. 
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I. INTRODUCTION 

 

The use of fiber-reinforced composites is the key to 

lightweight construction, which is indispensable for modern 

life. Aerospace, automotive, shipbuilding or railway, rotor 

blades for wind energy generators or sports equipments – the 

applications for fiber-reinforced composites are manifold. 

Glass or carbon fibers, woven, unidirectional or multiaxial, are 

the most common reinforcements. Thermoplastic or 

thermosetting materials are used as matrices.  

 

In many high-performance applications epoxy resins 

are used as matrix materials. All known manufacturing 

technologies for fiber-reinforced composites are used in the 

industry in combination with epoxy resins. Ski poles are made 

by using filament winding of carbon fibers in combination with 

anhydride cured epoxy resins. Machine parts are manufactured 

by using amine cured glass fiber prepregs. Profiles are produced 

by pultrusion using liquid resin systems. Aerospace parts are 

made by using carbon fiber prepregs based on tetra functional 

epoxy resins cured with aromatic amines in an autoclave. The 

most popular manufacturing technologies are injection 

technologies like resin transfer moulding (RTM), single-line 

injection (SLI), vacuum assisted resin transfer moulding 

(VARTM) etc. due to the relatively short manufacturing cycles. 

Rotor blades for wind energy generators are manufactured 

mainly by using vacuum-assisted infusion techniques. 

However, the viscosities of the resin systems used for injection 

technologies need to be low.  

 

In engineering composite parts, e.g. a crank shaft for a 

sports car, the reinforcing fiber or fabric are nonwoven and their 

orientation towards the force along the part are of utmost 

importance. However, the choice of resin and hardener is 

important as well – to match performance as well as production 

cycle needs. Of course any improvement of the resin 

performance is welcome to help to improve the performance of 

the composite parts. 

 

Introduction To Fibers 

 

In our everyday life timber plays a significant role. 

However timber resources are getting depleted continuously 

while the demand for the material is ever increasing. According 

to the literature, by the beginning of the next century the wood 

will be scarce for the whole world (Singh, 1982). This situation 

has led to the development of alternative material. 

 

Among the various synthetic materials that have been 

explored and advocated, plastics claim a major share as wood 

substitutes. 

 

Plastics are used for almost everything from the 

articles of daily use to the components of complicated 

engineering structures and heavy industrial applications (Rai & 

Jai Singh, 1986). Plastics find an extensive application in 

buildings as flooring material because they are resistant to 

abrasion, have a low heat conductivity and low water 

absorption, sufficient hardness and strength. 
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They fail to swell when moistened, readily take on 

varnishes and paints. Hardware items like door and window 

frames, flushing cisterns, overhead water storage tanks and 

water fittings are commercially available and are finding 

acceptance in the building industry. Plastics are used to 

manufacture various sanitary wares, which include wash basins, 

bathtubs, sinks, shower cabins, washing racks and others. 

Plastic pipes are widely used in the installation of various 

industrial purposes, water supply etc. 

 

However, during the last decade, the study of filled 

plastic, the study of filled plastic composites has simulated 

immense interest in meeting the future shortage of plastic 

materials (Lightest, 1983). In fact, synthetic fibres such as 

nylon, rayon, aramid, glass, polyester and carbon are 

extensively used for the reinforcement of plastics (Erich et al., 

1984; Lawrence et al., 1995). 

 

Nevertheless, these materials are expensive and are 

non-renewable resources. Because of the uncertainties 

prevailing in the supply and price of    petroleum based 

products, there is every need to use the naturally occurring 

alternatives. In many parts of the world, besides the agricultural 

purposes, different parts of plants and fruits of many crops have 

been found to be viable sources of raw material for industrial 

purpose. In recent years, polymer composites containing 

vegetable fibres have received considerable attention both in 

the literature and in industry. 

 

The interest in natural fibre reinforced polymer 

composites is growing rapidly due to the high performance in 

mechanical properties, significant processing advantages, low 

cost and low density (Satyanarayana et al., 1990a,b). Natural 

fibres are renewable resources in many developing countries of 

the world; they are cheaper, pose no health hazards and, finally, 

provide a solution to environmental pollution by finding new 

uses for waste materials. 

 

Fibre Types And Scientific Names 

 

The following table 1.1 describes the fibre types and 

its scientific names.e most striking technical developments of 

recent years have been the rapid growth of World Wide Web. 

Web sites are identified by Uniform Resource Locator (URL) 

address. The browser access uniform resource locator entered  

 
 

Stress Strain Relationship of Various Fibres 

 

The cumulative distribution of strength is given by the 

following equation: 

 

F(σfu) = 1- exp [ -( Lf / Lo ) (σfu / σo ) ∞] 

 

Where F(σfu) represents the probability of filament 

failure at a stresslevel lower than or equal to F(σfu).The 

parameters and so in equation are called the Weibull 

parameters, and are determined using the experimental data. 

 

A can be regarded as an inverse measure of the 

coefficient of variation. The higher the value of a, the narrower 

is the distribution of filament strength. The scale parameter so 

may be regarded as a reference stress level. The stress strain 

diagram is shown in figure 1.1 

 
Fig.1.1 Stress Strain diagram 
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Manufacturing Methods 

 

The sisal fiber lies along the length of the leaf, being 

most abundant near the surface of the leaf where it is long and 

strong. The interior fibers are weaker, and they are usually 

removed during processing. It is usually obtained by machine 

decortications in which the leaf is crushed between rollers and 

then mechanically scraped. The fiber is then washed and dried 

by mechanical or natural means. 

 

Abaca is also called Manila hemp, abaca is extracted 

from the leaf sheath around the trunk of the abaca plant (Musa 

textiles), a close relative of the banana, native to the Philippines 

and widely distributed in the humid tropics. Harvesting abaca 

is laborious. Each stalk must be cut into strips which are scraped 

to remove the pulp. The fibers are then washed and dried. 

 

Handlay Up Method 

 

There are numerous methods for fabricating composite 

components. Some methods have been borrowed (injection 

molding, for example), but many were developed to meet 

specific design or manufacturing challenges. 

 

Selection of a method for a particular part, therefore, 

will depend on the materials, the part design and end-use or 

application. 

 

Composite fabrication processes involve some form of 

molding, to shape the resin and reinforcement. A mold tool is 

required to give the unformed resin /fiber combination its shape 

prior to and during cure. 

 

Resins are impregnated by hand into fibres which are in 

the form of woven, knitted, stitched or bonded fabrics. This is 

usually accomplished by rollers or brushes, with an increasing 

use of nip-roller type impregnators for forcing resin into the 

fabrics by means of rotating rollers and a bath of resin. 

Laminates are left to cure under standard atmospheric 

conditions. 

 

Figure 1.2 shows the Hand lay up process.  

Hand lay-up is the simplest and oldest open molding 

method of the composite fabrication processes. Glass or other 

reinforcing mat or woven fabric or roving is positioned 

manually in the open mold, and resin is poured, brushed, or 

sprayed over and into the glass plies. 

 

Testing Of Composites 

 

The mechanical tests of the composite includes tensile, 

flexural, impact were performed in order to find the mechanical 

properties of the composite. 

 

Tensile Test 

 

Tensile tests measure the force required to break a 

plastic sample specimen and the extent to which the specimen 

stretches or elongates to that breaking point. 

 

These tests are use to apply a stress to a material and 

record the materials response to this stress. The mathematical 

definition of stress (S) is the load (P) on a body distributes over 

the cross sectional area of that body. 

S = P / A  

 

A tensile stress tends to pull a member apart; a 

compressive stress tends to crush or collapse a body; a shear 

stress tends to cleave a structural member; a torsion stress tends 

to twist a member; a bending stress tends to deflect a member. 

Figure 4.2 shows the tensile testing machine. 

 

These machines apply a tensile load when one end of 

the test sample is attached to a movable cross head with the 

other end fixed to a stationary member. The cross head is then 

driven in such a manner as to pull the sample apart. A tensile 

test is performed by instrumenting the sample with an electrical 

device to measure strain (extensometer) and then stretching the 

sample until it falls. The stretch, both elastic and plastic, is 

called strain. Elastic strain is recoverable when the loads are 

removed; plastic strain by definition is irrecoverable. A material 

response to the three major forms of stress – tension, 

compression, and shear can be measured on a universal testing 

machine. 

 

ASTM D-638 Tensile Test Procedure 

 

Specimens are placed in the grips of the universal tester 

at a specified grip separation and pulled until failure. For ASTM 

D 638 t he test speed is determined by the material specification. 

Figure 1.3 shows the tensile test specimen. 
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Fig.1.3 Tensile Test Specimen 

 

Impact Test 

 

The data is often used to specify appropriate materials 

for applications involving impact. The test is also used to 

evaluate the effect of secondary finishing operations or other 

environmental factors on plastic impact properties. Figure 1.4 

shows the impact test specimen.    

 

The specimen is clamped onto the testing platform. 

The crosshead, with the attached Tup, is raised to the 

appropriate height and is released so it impacts at a specified 

speed. A load-deflection curve is produced 

 

Fig.1.3 Impact Test Specimen 

 

Flexural Properties Testing 

 

The flexural test measures the force required to bend a 

beam under three point loading conditions. The data is often 

used to select materials for parts that will support loads without 

flexing. Flexural modulus is used as an indication of a 

material’s stiffness when flexed. Since the physical properties 

of many materials (especially thermoplastics) can vary 

depending on ambient temperature, it is sometimes appropriate 

to test materials at temperatures that simulate the intended end 

use environment. 

 

Fig.1.3 Flexural Test Specimen 

 

ASTM D790 Flexural Test Procedure 

 

Most commonly the specimen lies on a support span 

and the load is applied to the center by the loading nose 

producing three point bending at a specified rate. Figure 1.3 

shows the Flexural Test Specimen. 

 

The parameters for this test are the support span, the 

speed of the loading, and the maximum deflection for the test. 

These parameters are based on the test specimen thickness and 

are defined differently by ASTM and ISO.  

 

II. EXPERIMENTAL INVESTIGATION 

 

In this chapter, the detailed analysis is carried out for 

a specimen via UTM (Universal Testing Machine) and to find 

the Tensile, flexural, Impact, Hardness and Temperature 

distribution respectively for the generated specimen. 

 

2.1 UTM [UNIVERSAL TESTING MACHINE] 

 

A Universal Testing Machine (UTM), also known as 

a Universal tester, materials testing machine or materials test 

frame, is used to test the tensile strength and compressive 

strength of materials. The “Universal“ part of the frame reflects 

that it can perform many standard tensile and compression tests 

on materials, components, and structures (in other words, that 

it is versatile).  

 

2.2 UTM PROCEDURE  

 

The setup and usage are detailed in a test method, often 

published by a standard organization. This specifies the sample 

preparation, fixturing, guage length (the length which is under 

study or observation), analysis, etc.  

 

The specimen is placed in the machine between the 

grips and an extensometer if required can automatically record 

the change in guage length during the test.  
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If an extensometer is not fitted, the machine itself can 

record the displacement between its cross heads on which the 

specimen is held. However, this method not only records the 

change in length of the specimen but also all other extending / 

elastic components of the testing machine and its drive systems 

including any slipping of the specimen in the grips.  

 

Only the machine is started it begins to apply an 

increasing load on specimen. Throughout the tests the control 

system and its associated software record the load and extension 

or compression of the specimen.  

 

2.3 ANSYS 

 

ANSYS is a complete FEA software package used by 

engineers worldwide in virtually all fields of engineering. 

ANSYS is a virtual prototyping technique used to iterate 

various scenarios to optimize the product. 

 

SOME SPECIFIC CAPABILITIES OF ANALYSIS 

 

Static Analysis 

 

It is the used to determine displacement, stress etc. 

under static loading conditions. Ansys can compute linear and 

non-linear types. (e.g. the large strain hyper elasticity and creep 

problems) 

 

Thermal Analysis 

 

The steady state analysis of any solid under thermal 

boundary conditions calculates the effect of steady thermal load 

on a system (or) component. 

 

PROCEDURE  

 

1. Start →Program → Ansys → Ansys product launcher  

 

2. Preference → Thermal →Ok  

 

3. Preprocessor → Element Type → Add→ Add→ Solid → 

Quad 4 node 55 → Ok  

 

4. Material Properties → Material Library → Import Library 

→ SI (MKS) → Ok  

 

Browse → C: Program file → Ansys INC →V140 → 

Ansys → Matlib → select any one material → open → Ok 

→ close  

 

5. Modelling → create → Area → Rectangle → By 2 corners 

→ Width =100, Height = 100 → Ok  

 

6. Meshing → Mesh Tool → Global , Set → Element type = 

10 → Click small size → Mesh → Select the object → Ok  

 

7. Solution → Define load → Apply → Thermal → 

Temperature → On lines → Select the left line  

8. → Temp Value = 40º → Apply → select the right side line 

→ Temp value = 120º C → Ok  

 

9. Solution → Define Load → Apply → Convection → on 

lines →  Film coefficient = 20, Bulk Temp = 20º C → Ok 

10. Solve → Current LS → Ok 

11. General postprocessor → Plot Result → Contour Plot → 

Nodal Solution → DOF Solution → Nodal Temp → Ok 

To check the Temperature at various point: Query Result → 

Subgrid solution → DOF solution → Temperature → Ok → 

click any point on the object Temperature value displayed on 

the screen. 

 
 

III. RESULT AND DISCUSSION 

 

Tensile test is a very common testing method that is 

used to establish the tensile force or crush resistance of a 

material and the ability of the material to recover after a 

specified dimension. The tensile & Flexural test results are 

tabulated as shown in Table.3.1 

 

Table 3.1 Tensile & Flexural test observation for Composite 

Material 

 

Test 

Taken 

Thickness 

(mm) 

Load in 

kN 
Displacement 

in mm 
   

Tensile 3 7.28 6.72 

 
Flexural 3 29 16.01 
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Table 3.2 Impact & Hardness test observation for Composite 

Material 

 

Test 

Taken 

Thickness 
Load kN Test value’s 

(mm) 

Impact 3 7.286 298 J 

Hardness 3 20 436 HBW 

    

 

Table 3.3 Comparison of Tensile and flexural tests for various 

natural fibre composites 

 

From the above table 3.3, the value of tensile and 

flexural strength as we measured on universal testing machine 

is higher compared to the Sisal and Jute composite. The Tensile 

and flexural strength increases and their values are 6.72 kN and 

29 kN respectively. 

 

An experiment was conducted on the stability and 

strength of sisal & abaca through three full scale tests. The 

following conclusions were made from the full-scale tests, it 

was clear that the global flexural buckling is the main failure 

mode of the fibre properties. 

 

The maximum stress it withstands before failing is its 

ultimate tensile strength. Ultimate tensile strength (UTS), often 

shortened to tensile strength (TS) or ultimate strength, is the 

maximum stress that a material can withstand while being 

stretched or pulled before failing or breaking. 

 

IV. CONCLUSION 

 

The characterization of the Abaca and Sisal fibre have 

the higher mechanical properties (Tensile, Flexural, Impact and 

Hardness) when compared to the sisal and coir composites. 

 

Due to the low density and high specific properties of 

Sisal and Abaca fibres, composites based on these fibres may 

have very good implementations in the automotive and 

transportation industry. 

 

The systematic and persistent research there will be a 

good scope and better future for Sisal and Abaca fibre – 

polymer composites in the coming years. 
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Test 
Sisal-Abaca Sisal-Jute Sisal-Coir  

S.No 

 

Load Elongation Load Elongation Load Elongation 

 

Parameter

s 
 

  kN mm kN mm kN mm 
 

         

1 Tensile 7.286 6.72 7.286 7.24 7.286 5.72 
 

2 Flexural 29 16.006 29 17.006 29 14.006 
 


